Lesson 2
Setting Up
Copyright

Copyright 2018 Intuit, Inc.
All rights reserved.

Intuit, Inc.
5100 Spectrum Way
Mississauga, ON L4W 5S2

Trademarks

©2018 Intuit Inc. All rights reserved. Intuit, the Intuit logo, Intuit ProLine, Lacerte, ProAdvisor, ProSeries and QuickBooks, among others, are trademarks or registered trademarks of Intuit Inc. in the United States and other countries. Other parties’ marks are the property of their respective owners.

Notice to Readers

The publications distributed by Intuit, Inc. are intended to assist accounting professionals in their practices by providing current and accurate information. However, no assurance is given that the information is comprehensive in its coverage or that it is suitable in dealing with a client’s particular situation. Accordingly, the information provided should not be relied upon as a substitute for independent research. Intuit, Inc. does not render any accounting, legal, or other professional advice nor does it have any responsibility for updating or revising any information presented herein. Intuit, Inc. cannot warrant that the material contained herein will continue to be accurate nor that it is completely free of errors when published. Readers should verify statements before relying on them.
Table of Contents

Lesson Objectives ........................................................................................................................................... 5

Creating a QuickBooks Company .................................................................................................................. 6

Starting the EasyStep Interview ................................................................................................................... 7

Entering Company Information ....................................................................................................................... 8

Choosing Your Company Industry ............................................................................................................... 9

Selecting How Your Company Is Organized .............................................................................................. 10

Customizing QuickBooks for Your Business ............................................................................................ 11

Setting Up What You Sell ............................................................................................................................. 12

Entering Sales Information ........................................................................................................................... 13

Entering Sales Tax Information .................................................................................................................... 14

Creating Estimates ...................................................................................................................................... 15

Creating Sales Orders .................................................................................................................................. 16

Choosing Remaining Preferences .............................................................................................................. 17

Choosing a Start Date ................................................................................................................................... 19
Lesson 2 — Setting Up

Reviewing the Chart of Accounts ......................................................................................... 20

Completing Company File Setup ........................................................................................... 22

Setting Up Additional Accounts ............................................................................................ 23

Adding Items .......................................................................................................................... 25

Review Activities .................................................................................................................... 27
Lesson Objectives

- To discuss decisions that must be made before using QuickBooks
- To create a new QuickBooks company using the EasyStep Interview
- To set QuickBooks preferences in the Interview
- To record the opening balance for a chequing account
- To enter customers, jobs, vendors, accounts and items for a QuickBooks company
Creating a QuickBooks Company

A QuickBooks company contains all the financial records for a single business. Before you can use QuickBooks you need to tell QuickBooks about your business so that it can set up your company file.

1. Express Start will setup a new company file for you based on some standard industry settings.
2. Detailed Start opens the EasyStep Interview and will give you more control over the fine tuning of your company file.
3. Your other options are to create a file by copying list data from an existing file, or by converting data from another accounting system.

In the Detailed Start option you will setup the following:

- Company Information
- Chart of Accounts based on your industry
- Company organization
- Sales information
- Sales tax information
- Estimates
- Sales receipts
- Preferences
- Business start date
- Creating an account and entering the opening balance
- Reviewing the Chart of Accounts
- Completing company file setup

\[\text{NOTES}\]
Starting the EasyStep Interview

To begin adding a new company:


2. Click the Create a new company file button from the No Company Open window or choose New Company from the File menu.

3. Click on the Advanced Start button to start the EasyStep Interview.

QuickBooks displays the EasyStep Interview window.
To create a new QuickBooks company file:

1. At the first Welcome window for the EasyStep interview the Enter Your Company Information window appears.

2. Enter the business name in the **Company Name** field and press **Tab**.
   When you press Tab QuickBooks automatically enters the same name you typed into the Legal Name field. QuickBooks uses the company name on all reports.

3. Complete the remaining contact information for the company, as QuickBooks will pull this information onto sales forms and tax reports when you begin working in the file.

   Your screen should resemble the following.

   ![QuickBooks EasyStep Interview](image)

   4. Click **Next**.
Choosing Your Company Industry

To choose your company industry to create a Chart of Accounts:

1. Choose your industry from the list to help QuickBooks compile a suggested Chart of Accounts for your business.

2. Click Next.

NOTES
Selecting How Your Company Is Organized

To select your company organization:

1. Choose the company’s entity type. This will allow QuickBooks to create suggested tax mapping for your Chart of Accounts.
2. Click Next.
3. Enter the beginning month of the businesses fiscal year (most commonly January) and click Next.
4. In the Set up administrator password window click Next.
5. Click Next to save the company file.
6. Name your company file and choose the location on your computer to save it to.
7. Click Save.

Notes
Customizing QuickBooks for Your Business

The customization section of the EasyStep Interview is where you indicate:

- What you sell
- How and when your customers pay you
- How you pay your bills

Based on your answers, QuickBooks sets preferences for the company file. The preferences enable certain features of the QuickBooks program.

Click Next.
Setting Up What You Sell

You need to indicate what your business sells. In general, businesses either sell products, services or both. Margaret Lockhart provides consulting services as well as selling products, such as fabrics.

To specify what you sell:

1. Click Next to move to the What do you sell? window.

2. Choose the appropriate option for the business.

3. Click Next.

Notes
Entering Sales Information

For retail companies you need to indicate how you want to enter sales. QuickBooks uses this information to set recommendations for a retail-type business.

To indicate how you enter sales:

1. In **Do you sell products online?** choose the option that best fits the business’s needs.

   ![Image of EasyStep Interview](image)

   - **I currently sell online.**
   - **I don’t sell online, but I may want to someday.**
   - **I don’t sell online and I am not interested in doing so.**

   QuickBooks will use this answer to display information about services that can help you sell your products on the Web.

   **Need help setting up?**
   - Find a local QuickBooks expert (fees may apply)

2. **Click Next.**

   **NOTES**
This part of the EasyStep Interview asks whether you charge sales tax. You should turn the sales tax setting off only if you never charge sales tax. Sometimes it is even beneficial to turn this feature on for tracking wholesale/retail sales, depending on the tax reporting regulations in your state.

**To set up QuickBooks to track sales tax:**

1. Click Yes in the Do you charge sales tax? window.
2. Enter the CRA and registration numbers, if applicable.

3. Click Next.
Creating Estimates

If you provide any type of estimate or bid — even a verbal quote — there are many reasons to use estimates in QuickBooks.

- Prepare professional-looking itemized estimates, bids, quotes or proposals for your customers
- Create an invoice from the estimate with just one click. QuickBooks then creates an invoice using information from your estimate
- Create reports that compare your estimated costs and revenue against your actual costs and revenue
- Compare your actual costs against what you estimated
- Track which estimates are still active and easily update each estimate as you continue to negotiate with your customers

To create estimates for your business:

1. On the **Do you want to create estimates in QuickBooks?** window choose the option that best fits the business.

2. Click **Next**.
Creating Sales Orders

Sales orders allow you to record an order for a sale before the sale is actually made. These forms are common in business that order products to fill orders or that pull orders from inventory before invoicing. These forms enable you to create partial invoices for an order if you have inventory items on backorder.

To create sales orders for your business:

1. On the Tracking customer orders in QuickBooks window choose the option that best fits the business.
Choosing Remaining Preferences

The next series of windows ask Yes or No questions that either enable or disable different QuickBooks features based on your company needs. Simply click Yes or No then click Next to move forward in the Interview.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billing statements</td>
<td>Post statement charges independently of invoices &amp; sales receipts</td>
</tr>
<tr>
<td>Progress invoicing</td>
<td>Create single estimates to be invoices in phases</td>
</tr>
<tr>
<td>Bill tracking</td>
<td>Use the Accounts Payable module to track bills and bill payments</td>
</tr>
<tr>
<td>Cheques</td>
<td>Use the Write Cheques window to print cheques</td>
</tr>
<tr>
<td>Inventory</td>
<td>Use inventory module to track inventory quantities and values</td>
</tr>
<tr>
<td>Credit Cards</td>
<td>Use Merchant Services to process credit and debit card transactions</td>
</tr>
<tr>
<td>Track time</td>
<td>Use timecards to track employee and subcontractor time</td>
</tr>
<tr>
<td>Employees</td>
<td>Use payroll module to manage employee information and payroll</td>
</tr>
<tr>
<td>Multiple Currencies</td>
<td>Track multiple currencies for buying and selling</td>
</tr>
</tbody>
</table>
You can always change preference settings later, after the EasyStep Interview. Changing the preferences later can be done by accessing the **Edit** menu then choosing **Preferences** and then selecting the preference type in the left panel.
Choosing a Start Date

The start date is the date for which you give QuickBooks a financial snapshot of your company assets and liabilities.

To choose a start date:

1. On the Using Accounts in QuickBooks window click Next.
2. Choose the option that best suits the business setup.

3. Click Next.

NOTES
Reviewing the Chart of Accounts

The Chart of Accounts is made up of five types of accounts common to all businesses — the income and expense accounts used by the Profit and Loss Statement and the asset, liability and equity accounts used by the Balance Sheet. Each time you enter a transaction QuickBooks will prompt you to categorize it into one of these five types of accounts.

Because you chose an industry from the list earlier in the Interview, QuickBooks has already created income and expense accounts for your company based on that choice.

To review the chart of accounts:

1. In the Review income and expense accounts window scroll through the preset accounts to get an idea of what is included. Modify the selections according to your business needs.

2. Click Next.

Congratulations! You have completed the Easy Step Interview.
3. Click Go to Setup.

The QuickBooks setup screen appears.

**NOTE:** When entering bank accounts and opening balances, the balance sheet accounts in the QuickBooks Chart of Accounts start with an opening balance of zero. Before you begin working in QuickBooks you need to enter an opening balance for each balance sheet account as of your start date. We recommend consulting your accountant if you aren’t sure what balance to use.

After you have completed the EasyStep Interview use the information in the Help options described later in this document to help you make changes and adjustments to your company file.
Completing Company File Setup

After you have created your company file using the EasyStep Interview you can begin using QuickBooks to run your business.

However, there are some additional tasks you might need to do to make sure the company file is properly set up and that the data is complete.

QuickBooks is based on four key concepts:

- Accounts
- Items
- Customers & Jobs
- Vendors

NOTES
Setting Up Additional Accounts

During the EasyStep Interview you added your bank accounts.

There are two basic types of accounts.

- **Balance sheet accounts**, such as savings or chequing
- **Accounts used to group transactions for reporting purposes**, such as income and expense accounts

Income and expense accounts track the sources of your income and the purpose of each expense. When you record transactions you usually assign the amount of the transaction to one or more income or expense accounts.

Accounts are the core of QuickBooks. Every posting transaction (which is a transaction that affects a report) is mapped from one account to another. For example, when you purchase paper for your office printer you are taking money from the bank account and recording it against an office supplies expense account. Your Chart of Accounts is home to all of the accounts (also referred to as categories) that show on your financial reports.

**To add an account:**

1. From the **Lists** menu choose **Chart of Accounts** (or press **CTRL+A**).
2. Click the **Account** menu button (at the bottom left of the window) and choose **New** (or press **CTRL+N** from the **Chart Accounts** window).
3. In the **Add New Account** window choose the appropriate account type then click **Continue**.
4. Click in the **Account Name** field name the account appropriately.
5. From the **Tax Line Mapping** drop-down list choose the appropriate mapping according to the business structure (or leave blank if you are unsure).
6. Click **Save & Close**.
Adding Items

Items are what we use on sales forms like Estimates, Sales Orders, Invoices and Sales Receipts. Items show the products/services that are sold and each item is mapped to one or more account in QuickBooks. Items can be mapped to one, two or three accounts in QuickBooks.

**One-Sided Items** — These are items we only use on either a sale or purchase form, but not both. For example, if you sell consulting services you may have an item named Consulting for use on your invoices. This item will be mapped to an income account for you to view on your Profit & Loss report. If this item were used on a purchase transaction it would post a negative transaction to your income account.

**Two-Sided Items** — These are items we use on both a sale and a purchase form. The setup for these items allows you to post to an income account when used on a sales form and post to an expense account when the item is used on a purchase form.

**Three-Sided Items** — Three sided items are used for inventory. The setup of these items allows you to purchase the item and receive it into your Inventory Asset account (part 1). When you sell the inventory the item posts to your Income account (part 2) and also makes a Cost of Goods Sold entry (part 3).

In this section we are going to look at one-sided item entry.

To add a One-Sided item:

1. From the Lists menu choose Item List.

2. Click the Item menu button at the bottom left of window and choose New.
3. In the **New Item** window choose an item type from the **Type** drop-down list.

   *NOTE: When you select an item type a description of how that item should be used will appear to the right of the drop-down box.*

![New Item Window](image)

4. Assign an item name or number in the **Item Name/Number** field.

5. In the **Description** field enter the information that you would like to come up by default when this item is used on a form.

6. You can assign a standard rate in the **Rate** field.

7. In the **Tax Code** field assign a standard taxable or non-taxable code.

   *NOTE: Items marked as Non-Taxable in the setup will not accrue sales tax on sales forms. See the Sales Tax training section for additional information.*

8. In the **Account** field choose the appropriate account for income to post to when this item is used on sales forms.

9. Click **OK** to add the new item to the Item List.

10. Close the Item List.
Review Activities

Create a NEW company file and walk through the EasyStep Interview process.

Your company should be in the Construction industry and is a sole proprietorship that sells products and services. Your fiscal year should begin at the beginning of the current year.